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Upgrade Complexity 

 From prior version: Easy � 

Enhancements and revisions in Adagio PurchaseOrders 8.1

Features 

♦ You can now search the details on purchase orders, receipts 
added on the Details tab and Find Line added to the right

♦ You can now select which vendors of a multiple vendor document to print when 
the grid. The vendors appear in a list on the print dialog. Vendors that do not have Print, Fax or Email set in Send Method f
Print Options do not show on the list. If one of the options is set, the vendo
record. For example, if the vendor is set to Print only, it will show on the list but documents will not be faxed or emailed.

♦ You can now manually prorate multiple Miscellaneous Charges.

♦ Supports Transport Layer Security (TLS) / Secure Socket Layer (SSL) for secure email servers when emailing documents. Added 
option 'Use TLS/SSL' added to Email Setup function.
Notes). 

♦ Text Blocks can be defined and added to 
defaults to disabled in any existing Security 

♦ Added the new sort Category / Item Number

♦ If you add a new Ship To Address on the fly after using Import OE Lines, when you click the ShipTo button on the Bill to / Ship to tab 
it asks the question "Do you want to create a ship 
you to use the customer's address from the OE order. The Ship To code is set to the Customer Number.
already exists it asks "An address exists with the cod

♦ When adding an IC item on the fly while entering purchase orders the vendor from the detail is set as the Primary Vendor in t

♦ You can now change the Adagio JobCost allocation on details in receipts.

♦ Code 39 barcodes could be printed for any field on purchase orders and other documents in previous versions. However, these 
barcodes could not be scanned because they were missing the leading and trailing asterisk. Added Bar Code Font field to the 
System tab in the Program Properties function in the designer. Fields using this font on documents will print a barcode that can be 
scanned. Note: The barcode font is not embedded in PDFs or email attachments and
that prints the documents. Typically fonts will be installed on all machines at a site and barcodes will print. However, this will be a 
limitation when sending documents by email. Barcodes will be embedded in a future release.

♦ Added M19, Company Contact spec code in the

♦ The status bar now shows activity of various steps when the program is starting up and the database is opening.

♦ Added 'Auto-backup after DIC' option to the System Options tab in the 

♦ Added Filter criteria 'Before today' and 'After today'

♦ A 'Report set' button has been added to the toolbar.
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Release Notes  

date compatibility information is on the Product Compatibility Info

Adagio 
Crystal Reports® 8.5-B for Adagio 
Console 9.1A 
DataCare 8.1A - 9.1A 
ePrint 9.0A 
GridView 8.1A – 9.1A 
Inventory 8.1C, 8.1D 
JobCost 8.1B, 8.1C 
Lanpak 9.0E 
Ledger 9.0C – 9.1A 

 
MultiCurrency 8.1B
ODBC 9.0A, 9.1A
OrderEntry 8.1D
Payables 8.1D 
Purchase Orders for Adagio
 
Other Products
MS Office 2003
MS Windows XP

Enhancements and revisions in Adagio PurchaseOrders 8.1D (2014.03.10) 

You can now search the details on purchase orders, receipts and other documents using the smart finder. A Find button as been 
added on the Details tab and Find Line added to the right-mouse menu on the grid. 

You can now select which vendors of a multiple vendor document to print when auto-printing individual documents 
the grid. The vendors appear in a list on the print dialog. Vendors that do not have Print, Fax or Email set in Send Method f
Print Options do not show on the list. If one of the options is set, the vendor will show on the list but printing will match the vendor 
record. For example, if the vendor is set to Print only, it will show on the list but documents will not be faxed or emailed.

You can now manually prorate multiple Miscellaneous Charges. 

ransport Layer Security (TLS) / Secure Socket Layer (SSL) for secure email servers when emailing documents. Added 
option 'Use TLS/SSL' added to Email Setup function. Note: this will require a workstation install (see Upgrading topic in Release 

Blocks can be defined and added to purchase orders as multiple comment or instruction lines. Note that Edit Text Blocks 
Security Groups if you are using Adagio security. 

sort Category / Item Number when sorting lines on a document or sorting lines when printing a document.

ddress on the fly after using Import OE Lines, when you click the ShipTo button on the Bill to / Ship to tab 
it asks the question "Do you want to create a ship to address, and use the OE address as the default?".  Responding “Yes” 
you to use the customer's address from the OE order. The Ship To code is set to the Customer Number. 
already exists it asks "An address exists with the code from OE, do you wish to updated it?". 

When adding an IC item on the fly while entering purchase orders the vendor from the detail is set as the Primary Vendor in t

You can now change the Adagio JobCost allocation on details in receipts. 

arcodes could be printed for any field on purchase orders and other documents in previous versions. However, these 
barcodes could not be scanned because they were missing the leading and trailing asterisk. Added Bar Code Font field to the 

Program Properties function in the designer. Fields using this font on documents will print a barcode that can be 
scanned. Note: The barcode font is not embedded in PDFs or email attachments and, therefore, must be installed on the computer 

e documents. Typically fonts will be installed on all machines at a site and barcodes will print. However, this will be a 
limitation when sending documents by email. Barcodes will be embedded in a future release. 

spec code in the document designer. 

The status bar now shows activity of various steps when the program is starting up and the database is opening.

the System Options tab in the Company Profile. 

and 'After today' for Floating Date Range. 

A 'Report set' button has been added to the toolbar. 
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(2014.03.10) 

Product Compatibility Info link at www.softrak.com. 

8.1B 
9.1A 

D - 8.1F 
 - 8.1F (required) 

Purchase Orders for Adagio 8.1B 

Other Products 
MS Office 2003, 2007, 2010 
MS Windows XP, Vista, 7, 8, 8.1 

and other documents using the smart finder. A Find button as been 

printing individual documents or printing from 
the grid. The vendors appear in a list on the print dialog. Vendors that do not have Print, Fax or Email set in Send Method for PO 

r will show on the list but printing will match the vendor 
record. For example, if the vendor is set to Print only, it will show on the list but documents will not be faxed or emailed. 

ransport Layer Security (TLS) / Secure Socket Layer (SSL) for secure email servers when emailing documents. Added 
Upgrading topic in Release 

Note that Edit Text Blocks 

orting lines on a document or sorting lines when printing a document. 

ddress on the fly after using Import OE Lines, when you click the ShipTo button on the Bill to / Ship to tab 
.  Responding “Yes” allows 

 If the Ship To Address 

When adding an IC item on the fly while entering purchase orders the vendor from the detail is set as the Primary Vendor in the item. 

arcodes could be printed for any field on purchase orders and other documents in previous versions. However, these 
barcodes could not be scanned because they were missing the leading and trailing asterisk. Added Bar Code Font field to the 

Program Properties function in the designer. Fields using this font on documents will print a barcode that can be 
must be installed on the computer 

e documents. Typically fonts will be installed on all machines at a site and barcodes will print. However, this will be a 

The status bar now shows activity of various steps when the program is starting up and the database is opening. 
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♦ The Item button on details in documents opens the Item Inquiry with Sales and Costs rather than the standard Item Inquiry if security 
permits. 

♦ The Data Integrity Checker detects and deletes orphaned document header records when there is no totals record or details records.  

Problems Fixed 

♦ If you edited the primary vendor and vendors on details such that a vendor that was used is no longer used on the purchase order, 
the vendor was not removed from the View tab. It remained until posting so changes to the vendor where not lost in case you used 
the vendor again. Now the vendor does not show on the View tab or print if there are 0 lines for the vendor. 

♦ Edits to tax amounts were lost if multiple vendors on a purchase order were invoiced separately. 

♦ An Access Violation occurred if you quickly clicked between the View and Total tabs without letting the document load on the View 
tab. 

♦ When you entered a Receipt for a PO with manually prorated Miscellaneous Charges that had already been partially received, the 
warning message about the remaining amount to be allocated showed the wrong amount. 

♦ The warning for an inactive vendor was displayed for every detail added to the purchase order. It is only displayed once now on the 
edit of an existing purchase order and when creating a new purchase order, once on the header and once for the first detail. 

♦ When importing an order from OrderEntry, if you respond Yes to the 'Do you want to use the vendors on the IC items?' prompt, IC 
items that do not have a vendor specified in the item are now assigned the vendor from the purchase order header. In some cases in 
version 8.1C, the vendor was left blank and a integrity error resulted when this occurred. There were further problems if these items 
were receipted and invoiced. For purchase orders where this may have happened, you cannot post until it has been corrected. If this 
has happened, the Data Integrity Check will assign the primary vendor on the purchase order to these items. If Day End has been 
done, adjustments will need to be made. You are now prevented from posting a Receipt or Invoice/Adjustment when there are a 
blank vendors. 

♦ On the Details tab when editing or viewing a purchase order, if you clicked the triangle button to hide the vendor information and 
clicked it again re-show the information, the Change Vendor appeared. 

♦ The Db GL Account field for Sundry Items could not be edited on receipts. 

♦ Posting a purchase order with a Sundry vendor as the primary vendor, that also included a item with a Payables vendor, incorrectly 
displayed an error that the Sundry vendor was not found. Starting with either a Payables or Sundry vendor, and then adding an item 
with the other type, now sets the vendor type value correctly even if an IC item is set with the primary vendor having a sundry code. If 
the primary vendor code on the IC item isn't a Payables or Sundry vendor, then the correct 'vendor code doesn't exist' message 
appears. 

♦ The Day End process may have created incorrect GL entries to the Ledger rounding error account when Receipts were partially 
invoiced. When Misc Charges are allocated on a Receipt and Item details are deleted from the Invoice/Adjustment, all Misc Charge 
details will be deleted from the Invoice/Adjustment entry. The cost allocations from the Receipt are not reversed. A new Misc Charge 
may be added to the Invoice/Adjustment to update the Items on the Invoice/Adjustment. When the remaining Items on the Receipt 
are invoiced, the Misc Charges can be adjusted if needed.  

♦ The grid was not refreshed correctly, in some cases, in the Auto Generate function after generating purchase orders. 

♦ Taxes were not added to purchase orders created for the Auto Generate function. 

♦ When printing a Report Set, your choice on the message dialogs displayed is remembered. If you select the option 'Don't show this 
message again' the dialogs will no longer be displayed and the action taken will be for the remembered choice.  

♦ Importing documents containing new IC items that do not have Item Location records caused data integrity errors in the Total 
Quantity on PO that could not be rebuilt correctly. 

♦ For formatted item numbers, if you added an IC item in Adagio Inventory (or other modules) by copying and pasting the item number 
and you inadvertently included a CR/LF, the item was added and could be seen in grids and finders in any module. However, when 
selected an error displayed saying "Record not found". This is now prevented in Adagio PurchaseOrders. Likewise for formatted 
document numbers, if you created a purchase order or receipt and manually assigned the document number by copying and pasting 
a number with a CR/LF, the document posted and could be seen in grids and finders but, when selected, an error displayed saying 
the document was not found. 

♦ The smart finder did not work for Sundry Items that had leading spaces in the Item Number. 

♦ The Data Integrity Check now checks for details on purchase orders where the Qty Ordered * Unit Cost doesn't equal Extended 
Cost.  

♦ Installs an updated version of the Adagio Data Source (ADS) that correctly records the OpLocks setting shown in station log files. 
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Installing 

To install Adagio PurchaseOrders you need the serial number and install code from the download instruction email sent to you by 
Softrak Systems. 

If you are installing an upgrade, you need the upgrade serial number and install code from the upgrade download instruction email. A 
previous version of Purchase Orders for Adagio should already be installed on your computer before installing the upgrade. If a 
previous version is not already installed, you can still install the upgrade. After entering the upgrade serial number and install code, you 
will also have to enter the serial number and install code from a previous version. 

Read the section ‘Upgrading to this Version’ below before installing an upgrade. 

If you are installing a Service Pack, you do not need to enter a serial number or install code. However, a previous version of Adagio 
PurchaseOrders 8.1D must be installed before the Service Pack can be installed. 

To install Adagio PurchaseOrders (or an upgrade), run the program file you downloaded. Once the install program is running you can 
click the View button to open the Readme file for detailed instructions. If Adagio PurchaseOrders is installed on a network, you may 
need to also do a workstation install for each workstation running Adagio PurchaseOrders. Refer to “Installing on a network” in the 
Readme for instructions. 

To install the Adagio PurchaseOrders Service Pack, run the Service Pack program and follow the instructions on the screen. After 
installing the Service Pack. A workstation install will not be required 

Adagio PurchaseOrders requires Adagio Payables and a Payables database must exist for PO to run. 

PurchaseOrders requires some Adagio modules to be at a certain version or higher. See compatibility information below or the 
Adagio Compatibility Chart. 

Adagio PurchaseOrders 8.1D requires Adagio Lanpak (if used) to be version 9.0E or higher. 

Adagio PurchaseOrders 8.1D requires Adagio Payables to be 8.1D or higher. If an earlier version of Payables data is detected an error 
message is displayed and PurchaseOrders will not open the database. Adagio Payables 8.1E or higher is recommended, as these 
versions support the new PO related fields in vendors. 

Adagio PurchaseOrders 8.1D requires Adagio Ledger (if used) to be 9.0C or higher. If an earlier version of Ledger data is detected an 
error message is displayed and PurchaseOrders will not open the database. 

Adagio PurchaseOrders 8.1D requires Adagio Inventory (if used) to be 8.1C or higher. If an earlier version of Inventory data is detected 
an error message is displayed and PurchaseOrders will not open the database. 

You will need to be running Inventory 8.1D and have installed the 8.1D (2012.05.12) Hot Fix or a higher version if the following applies 
to you. PO writes a Sundry vendor code to an IC item if the company profile is set to 'Update IC primary vendor' when creating and 
saving a PO detail. The Edit Item function in IC verified the Vendor Codes against Payables only and forced a clear if the Vendor field 
was edited and it contained a Sundry vendor. Sundry vendors are now supported. This is not an issue in the Edit Item function in PO. 

Adagio PurchaseOrders 8.1D requires Adagio OrderEntry (if used) to be 8.1D or higher. If an earlier version of OrderEntry data is 
detected an error message is displayed and PurchaseOrders will not open the database.  

Adagio PurchaseOrders 8.1D requires Adagio JobCost (if used) to be 8.1B or higher. If an earlier version of JobCost data is detected an 
error message is displayed and PurchaseOrders will not open the database. 

PurchaseOrders does not have a Manual in PDF form. Use the online help instead. The help fully documents all aspects of the product. 

Updating to 8.1D from 8.1C     Upgrade Complexity: Easy � 

If this upgrade is installed on a network, a workstation install for each workstation running Adagio PurchaseOrders will be 
required if no other module that supports TSL/SSL for secure email servers has been installed. Refer to “Installing on a network” 
in the Readme for instructions. A workstation install of PurchaseOrders must also be done on all stations that use email in any 
other module, such as OrderEntry, even if the station does not use PO. 

Before installing the new version you should perform a Data Integrity Check of your database(s) at your current version to ensure there 
are no integrity errors. 

The Data Integrity Check (DIC) now checks for details on purchase orders where the Qty Ordered * Unit Cost doesn't equal Extended 
Cost. This check was not done in PO 8.1C. Therefore errors, while rare, may be reported by the DIC after upgrading. The errors were 
likely created in POA. The DIC cannot rebuild these errors because it has no way of knowing which value to correct. To correct these 
errors, you must edit the details on the purchase orders and manually correct the appropriate field as needed. 

There are no other special considerations when upgrading to Adagio PurchaseOrders 8.1D from version 8.1C and no database 
conversion is required. The information below can be skipped. 

Upgrading from Purchase Orders for Adagio version 8.1A or 8.1B             Upgrade Complexity: Intermediate � 
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Do not install this upgrade until you are certain you have the versions of other Adagio modules required above are installed or 
are available to install. The upgrades to the other modules may be installed before or after installing the PurchaseOrders upgrade. 

You should perform a Data Integrity Check in your current version before installing the new version. Any errors should be rebuilt or dealt 
with in your current version before using 8.1D. 

Adagio PurchaseOrders (PO) will be installed to the \softrak\purchaseorders folder. Purchase Orders for Adagio (POA) was installed in 
\softrak\powin. Installing an upgrade from POA to PO does not uninstall POA and leaves the powin folder undisturbed. However, if the 
install detects that POA is installed it will inform you. You can use both PO and POA on the same database but cannot have the two 
programs open at the same time. If you have databases for multiple companies and do not want to convert them all at the same time 
you will be able to continue to run older versions of POA on those databases. 

Install Adagio PurchaseOrders in the same \softrak folder as Purchase Orders for Adagio. If this is not done, posting documents in POA 
will cause data integrity errors in PO. 

The upgrade install cannot change any custom icons you may have created to launch POA and they will continue to run that version. 
You must change these icons manually or create new ones to run PO from \softrak\purchaseorders\purchaseorders.exe. 

Adagio PurchaseOrders 8.1D does a minor conversion from Purchase Orders for Adagio 8.1A or 8.1B and may be installed at any time. 
The conversion does not affect running POA on the data. It only creates new files for its own use the first time you open an existing 
POA database. The message "This Adagio PurchaseOrders has security groups or Screen defaults that need to be converted... Do you 
wish to convert this data?" is displayed. Answer 'Yes' to be able to use PO, otherwise answer 'No' to continue using POA only and make 
no changes to the database. The conversion asks if you've made a backup and offers to make one. The conversion should take only a 
few moments. 

After converting your data to 8.1D, the program forces you to do a Data Integrity Check (DIC). All functions are disabled until a DIC has 
been performed. 

Adagio PurchaseOrders will run side-by-side with Purchase Orders for Adagio programs. That way, if you discover a circumstance that 
the new version treats differently, you will be able to use the old program without worrying about any data conversion while we address 
the discrepancy. 

However, PurchaseOrders 8.1D (PO) and Purchase Orders for Adagio (POA) cannot be used concurrently at the same time on 
the same database as this may cause data corruption. It is okay to use both products on a database, but you cannot have the two 
programs open at the same time. If you attempt to open PO when another user has POA open on a database, the error "Unable to 
obtain access to PurchaseOrders database, currently being accessed by [user name] in [POA<machine name>]." will be displayed. If 
you attempt to open POA when another user has PO open on the same database the error "An error occurred while attempting to 
create a task. The database is exclusively locked by another user. Please try again later." will be displayed. 

PO does not use and does not convert existing purchase order, receipt or other document specifications (.rtm files) from POA. They 
must be manually recreated. Start with templates in the PurchaseOrders Designer program or specifications from the sample data. PO 
includes default specification documents that are very similar to the defaults in POA. Many of the POA documents provided to Softrak 
by users/dealers were recreated for PO. You should be able to find document specifications that are close to the documents you use in 
POA. Your company logo and company address will need to be added, and other changes may be required. Spec codes may not be 
available for fields that were possible to print on documents in POA. 

PurchaseOrders does not convert existing POA Import or Export templates. However, the default templates from POA have been 
predefined as default templates in PO. Imports and exports from other systems using the POA default templates should therefore work 
without requiring changes to the files from the originating system. 

Security Groups in PurchaseOrders use the Adagio standard. The Purchase Orders for Adagio settings for menu choices are converted 
for use by PO. Other security settings in Groups are not converted and must be set up in PO as required. Note that POA security has 
levels of Low/Medium/High/System that PO does not have. If both PO and POA are used, settings in one do not affect the other. 

There are additional checks in the Data Integrity Check (DIC) in PO that were not done in POA. Therefore PO will likely find errors in 
databases where POA reported no errors. This is not a cause for concern and the errors can be rebuilt without loss of data. If you 
continue to post in POA, the DIC in PO may report new errors. DataCare will also detect and rebuild these errors. Running a DIC in 
POA may cause errors to be reported by PO. These errors can be rebuilt without loss of data. The DIC should therefore only be run 
in PO or DataCare. 

POA's day end will generate DIC errors in Adagio PurchaseOrders. It is therefore recommended that day end processes be 
performed in Adagio PurchaseOrders if you continue to use POA. Purchase Orders for Adagio was not properly completing PO's and 
incorrectly calculates the Outstanding Balance on PO for a vendor. These DIC errors are detected and fixed in Adagio PurchaseOrders. 

PurchaseOrders is not compatible with ACCPAC® Plus™ Job Costing (DOS). If you are using Plus JC you must convert to Adagio 
JobCost before installing and running PO. It will not convert POA databases that are interfaced to Plus JC and will not open these 
databases. 

Note: The Edit Vendor and Edit Item functions now use a Lanpak license. If another user is already in Payables or Inventory this would 
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require Adagio Lanpak to be installed. The view functions and sundry edits do not use a license, neither does adding a vendor or item 
"on the fly". Viewing vendors and items from within PO documents does not use a license but editing does. 

Adagio PurchaseOrders 8.1D installs a new Crystal Reports for Adagio table POW81. Custom reports created with tables for earlier 
versions should be updated to use the new table, although they will continue to work in most cases. 

GridView views originally created for earlier versions should be adjusted to use the 'Adagio PurchaseOrders 8.1C' dictionary (@U81C) 
to ensure that the information displayed is correct. Views used with GridView-RW MUST use current dictionaries to avoid the 
possibility of data corruption. 

Refer to the section 'Upgrading to 8.1D – converting custom reports and views' below for further details. 

After installing PO 8.1D, GridView will not show the 'Purchase Orders for Adagio 8.1A-8.1B' table when creating a new view unless you 
set the 'Show All Tables' option in Edit | Defaults. 'Adagio PurchaseOrders 8.1C' table will always be shown. As stated above, you 
should not be using Views created for POA once PO is installed. 

If you have Adagio ePrint, the message "Do you want to turn on Allow PDF printing for this dataset, and enable PDF Printing for all 
users?" will be displayed the first time you open a database. Answer Yes to save having to manually enable PDF Printing for each user 
in the User Preferences function. 

Upgrading from Purchase Orders for Adagio versions earlier than 8.1A        Upgrade Complexity: Difficult � 

PurchaseOrders 8.1D does NOT convert databases from Purchase Orders for Adagio versions earlier than 8.1A (i.e. versions 
from Purple Software Solutions). It does not convert databases from Inventory Receipts (IR) DOS databases or ACCPAC® Plus™ 
Purchase Orders (DOS). These databases can usually be converted but PurchaseOrders does not do this conversion. Contact your 
Adagio dealer or consultant if you need to convert these databases. There may be a charge for these services. 

Databases interfaced with ACCPAC Plus Job Costing need to be converted for use with Adagio JobCost before you convert to PO 
8.1D. A conversion program POAAJCvt.exe was installed by POA in \softrak\powin for this purpose. 

Upgrading to 8.1C or higher – converting custom reports and views 

Reports 

The main Crystal table for Purchase Orders 8.1C and higher is ‘POW81’ and replaces the 'IR65A' table for POA. Custom reports 
created in Crystal Reports for Adagio for POA with IR65A should recreated or convert using POW81. However, reports created for POA 
should continue to work without change as the data structure has not changed for PO 8.1D. Future release will require reports to be 
recreated or converted. 

Crystal Reports allows you to convert reports from one database to another by selection POW81 as an alias to IR65A. If any fields 
cannot be mapped automatically you can manually map those fields to the correct new field. 

Views 

GridView views originally created for POA using 'Purchase Orders for Adagio 8.1A - 8.1B' (PI80A) must be adjusted to use Adagio 
PurchaseOrders 8.1C and higher (@U81C). Views used with GridView-RW MUST use current dictionaries to avoid the possibility 
of data corruption. GridView 9.0A (2008.11.06) or higher has the ability to convert existing views when the dictionary changes with the 
release of an upgrade version of an Adagio module. 

The terminology in POA has changed from "Order" meaning a purchase order, to "Purchase Order" or "PO", to differentiate from an 
order in OE, which PO always refers to as a "Sales Order". The terminology has changed from "Price", meaning your vendor's price in 
POA, to "Cost", meaning your cost in inventory. 

Terminology changes for Order and Price have been made to field names in the data dictionary. GridView will not be able to convert 
fields in views for which the field name changed. For fields that cannot be converted you will see a message during the conversion. 
Note fields from the message and make adjustments to converted view as required. Columns that depend on fields that could not be 
converted will be removed. In formulas, fields that could not be converted will be changed to "Undefined Field". 

Changes and differences between POA and PO 

Although PO has virtually all of the functionality of POA, there are some differences to be noted including, but not limited to, the 
following: 

PO does not have an option to create an intermediate batch for import to Payables. Day End always posts receipt and invoice 
transactions directly to a batch in Payables. If the option 'Direct batch posting to AP' was disabled in POA it will be enabled. 

PO does not have an option to create an intermediate batch for import to JobCost. Day End always posts cost transactions to a batch in 
JobCost. If the option 'Direct batch posting to JC' was disabled in POA it will be enabled. 

Standard Adagio Styles and Filters replace the document status coloring and selection scheme in POA. Styles and colors are applied 
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by the conversion. Detail lines in documents color-coded for Contract, Price List and Complete using Styles. 

PO does not do Returns. POA did Returns although there were problems in this area. Use a negative Quick Receipt in PO to return 
goods. Returns entered in POA will not be processed by Day End in PO. 

PO does not use or need the Grid Mode (Extended or Quick) option found the Documents screen in POA. Use filters to change the sort 
order of the grid. 

Copy of POs and Requisitions is done from the Document List screen rather than with the Duplicate button in the document. 

The terminology has changed from "Order" meaning a purchase order in POA, to "Purchase Order or PO" to differentiate from an order 
in OE, which PO always refers to as a "Sales Order". 

The terminology has changed from "Price", meaning your vendor's price in POA, to "Cost", meaning your cost in inventory. 

Terminology changes for Order and Price have been made in the data dictionary and are visible in grids, finders, smart finder and 
Adagio GridView. 

Many ‘Alt-? key’ shortcuts have changed to accommodate new functions. 

Menus and the Toolbar have changed. Company Profile tabs and field positions have been changed from what is in POA. See the 
document 'PO 81B Company Profile options - Menus PO 81C.pdf, available on the Tech-Tips page on Softrak's website 
http://www.softrak.com/resources/adagiotips.php. 

The Restore function from History now copies a document to create a new purchase order (in the same way that OE Restore from 
history works), instead of moving back a collection of documents (PO, receipts and invoices) from History to Current in POA. 

PO generally has fewer pop-up warnings than POA. In some cases where there was a warning in POA the fields necessary to alert you 
to the warning condition are included on screens instead. For example, PO has a warning fields on details, such as * under stocked*. 

The Forms tab in Security Groups in POA does not exist in PO, however most setting from the tab can be achieved in PO. 

Reports are printed from individual menu choices rather than a Reports dialog of all reports. 

The Purchase order/receipt/return Listing is now called the Transaction Listing. 

The Outstanding Purchase Orders report has been redesigned. It is no longer that similar to the same report in POA. It is based on 
details and allows listing only outstanding items on partially received purchase orders. 

The Edit Item function in POA has a Pictures tab with 3 item images. PO does not have this. POA does not support the picture file on 
the Image tab in the Edit / View Items functions in Adagio Inventory, PurchaseOrders and OrderEntry. 

PO does not have the Statistical Analyzer function in POA.  

PO does not have or support the audit trail of changes to the Company Profile in POA. 

PO does not have the Compress DB function found on the Tools menu in POA. Use The 'Compact indexed files' option in DataCare 
instead. 

PO does not have a function to restore data from backup. Adagio modules do not include a restore function because there are many 
potential issues to be considered when restoring data. These include determining which backup to restore, which related data to restore 
or not, depending where you are in your accounting cycle with other modules, deleting the target data before restoring to prevent 
integrity errors, and ensuring you have a backup of the current data in case the backup file you are about to restore is corrupt or the 
restore is not viable for any reason. 

The Export function in POA includes a generic export feature allowing you to export most tables in the database. It exports to several 
formats. The Export function in PO supports only certain tables. To export other tables use the ExcelDirect feature from edit/view 
functions or the from the smart finder function. Or use Adagio GridView to export any table to Excel and from there to other formats as 
required. 

The document print dialog in PO displays a list of vendors for multi-vendor documents and allows you to select which vendor(s) to print. 
It does this for single documents only, whereas POA provides this function when printing a range of documents. Note: Vendors that are 
set to not print, email, fax do not show on the list. 

Email Covers are defaulted by user in POA, allowing them to be customized based on who is handling the purchase order. When a user 
has access to the Email Setup, they are able to set a 'Default cover sheet' which is defaulted for that particular user. 

In PO, there is no Tax button on the Totals tab when editing documents like there is in POA. Instead of a Tax Button, PO has an Edit 
Tax check box on the Totals tab. Select the vendor you wish to change the tax for, enable Edit Tax and edit the tax for each Jurisdiction 
as required. The difference will be applied to the first detail line with tax. If no lines have tax the difference will be applied to the first 
detail. 

The Primary Vendor field for the purchase order has been moved to the top of the top of the screen on the Header tab to make it more 
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prominent. 

Specification codes for printing Miscellaneous Charges as totals have been added. 

Transaction entry in POA has the option 'Always show Additional Item Information and Serial numbers' on the Details tab. PO always 
shows these lines. 

The 'Cost adjustment allocation' field in the Company Profile has been removed. The 'To GL cost of sales' setting did not work in POA. 
Therefore 'To remaining stock' is always used. POA has this option but it does not work. This may be implemented in a future release of 
PO when it no longer has to remain compatible with POA. 

PO cannot print "Page x of y" on documents. 

PO Receipt entry allows changing the JobCost allocation from the original purchase order detail (implemented in 8.1D). POA allowed 
changing the allocation on Invoices / Adjustments. PO does not allow this as POA will only distribute the difference to JobCost (tax, unit 
cost adjustment, Miscellaneous Charge, etc.) and does not correct the JobCost postings from the Receipt, potentially causing problems. 

 
-- end -- 


